Consigli sull'A.P.R.S.

Consigli per un corretto utilizzo del’APRS
(Automatic Position Reporting Sistem)
(Versione solo testo del 19 giugno 2006)

A cura di Marco Bombelli IK2CHZ — K2CHZ

(Si auspica la massima diffusione di questo documento
purché ne sia citato l'autore)

Premessa

Credo sia doveroso ricordare prima di tutto due
radioamatori che hanno fatto la storia dellAPRS.
Senza di loro tutto questo non sarebbe possibile.

Bob Bruninga WB4APR, ingegnere della US Navy
che ha inventato il sistema APRS.
( http://cadigweb.ew.usna.edu/~bruninga/aprs.html)
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Roger Barker G4IDE, prematuramente scomparso
'8 settembre 2004 poco piu che cinquantenne.
Autore di Ul-View. Il migliore e piu sviluppato
software per APRS. Ha lasciato un vuoto
incolmabile.

Qualche nota per quanto riguarda lo scrivente.
Sono nato nel '59, abito a Crema (CR) e sono
sposato con Cristiana IW2NVI — KCOQXT che ¢ |l
mio “supporto morale” in tanti momenti della mia
attivita radio. Lavoro all’aeroporto di Linate nel
settore operativo. Ho ottenuto il nominativo nel 1983
ed il mio interesse per la radio € sempre stato
orientato verso le HF e la caccia al DX. Ho
conseguito I' Honor Roll nel 2005 e nel 2006 ho
raggiunto l'obiettivo di aver collegato e confermato
tutte le entita DXCC. Nei primi anni 2000 ho
sostenuto gli esami radioamatoriali USA ottenendo
la Extra Class ed il nominativo K2CHZ. Nel 1999 ho
iniziato ad interessarmi anche all’ APRS. Sono stato
una delle primissime stazioni APRS della
Lombardia e credo di averlo sperimentato un po’ in
tutte le modalita: VHF, HF, internet, mobile (auto,
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moto, altro) e su piattaforme diverse: pc desktop,
portatili e PDA. Ho realizzato le prime mappe per
Ul-View e dal novembre 2004 ho installato a casa
mia una stazione meteorologica attiva H24 che
trasmettere ininterrottamente i dati meteo APRS sia
via radio che via internet.

Introduzione

Che cos’e 'APRS?

E’ un sistema di comunicazione che si basa
sulla trasmissione di dati digitali che
trasportano varie informazioni. | dati sono
normalmente in modulazione AFSK 1200 Bd, il
cosiddetto packet, ma in modalita non
connessa e quindi senza la certezza che |l
destinatario riceva correttamente cio che é
stato trasmesso, ma proprio per questo motivo
si ha la diffusione su vasta scala del segnale.
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Piu precisamente si tratta di pacchetti Ul
(Unnumbered Information) da qui il nome del
programma piu usato per 'APRS: Ul-View.

L’ APRS serve a trasmettere dati di stazioni
fisse, posizione di stazioni in movimento, dati
meteo di stazioni meteorologiche, messaggi fra
due o piu stazioni, bollettini, avvisi,
iInterrogazioni ad altre stazioni, ritrasmettere
dati di altre stazioni.

Lo scopo principale dellAPRS e soprattutto di
fornire informazioni in grandi aree locali e
guesto scambio di informazioni deve avvenire
nel modo piu affidabile possibile. L'APRS non e
fatto per tentare le comunicazioni a grande
distanza o i DX ma per un impiego tattico
locale. La sua applicazione ideale e in campo di
protezione civile. Citando 'inventore dell’ APRS
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Bob Bruninga APRS is a
real-time tactical digital communicatons
protocol for exchanging information between a
large number of stations covering a large (local)
area. As a multi-user data network, it is quite
different from conventional packet radio.”

Da qui il mio intento di dare delle indicazioni
sulla configurazione per fare in modo che sia
davvero affidabile.

Cosa serve per fare APRS?
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Per stazione fissa € necessario un computer,
un TNC o un modem Baycom o anche la sola
scheda audio del computer ed un normale RTX
FM su 144.800 MHz. In alternativa al TNC e al
RTX VHF si puo utilizzare una radio dedicata
con modem integrato come il Kenwood
TM-D700 o TH-D7 collegati direttamente al
computer.

Per la stazione mobile serve un GPS con uscita
NMEA 0183 seriale, un RTX dedicato per
APRS come i Kenwood TM-D700 o TH-D7
oppure un normale RTX FM su 144.800 ed un
interfaccia tipo Tiny Trak od alcuni tipi di TNC.
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Considerazioni

Scrivo questi consigli in seguito ad alcune
osservazioni fatte in questi anni di attivita in
APRS, dal lungo monitoraggio del traffico e dal
chiedermi il perché delle cose.

Le stazioni attive sono ormai da anni molte.
Osservando le configurazioni dei vari utenti mi
sono reso conto che la prima causa del QRM, e
quindi della scarsa efficienza del sistema,
siamo noi stessi. Per rendersene conto basta
ascoltare I'audio a 144.800, si sentono molti
pacchetti trasmessi contemporaneamente,
una collisione continua ed il rapporto fra quanto
ascoltato e quanto effettivamente e demodulato
& bassissimo.
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Premesso che risolvere totalmente il problema
e impossibile perché & intrinseco nella filosofia
di funzionamento dell'APRS, ossia I'essere tutti
sulla stessa frequenza e in modalita non
connessa, adottando opportuni accorgimenti si
potrebbe migliorare notevolmente la situazione.

Criteri di configurazione

| principali punti su cui intervenire sono cinque:

Frequenza di invio del beacon.
Indirizzamento del beacon.
Configurazione digipeater.
Messaggistica

Varie

ok~
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Capitolo 1: frequenza di invio del beacon.

Il beacon € il messaggio che contiene il
nominativo di chi lo invia, la codifica dell'icona
che identifica il tipo stazione, la posizione ed
altre informazioni. E’ quello che ci fa apparire
sulla mappa degli altri utenti, se ricevuto...

Molte stazioni inviano il beacon con una
frequenza troppo elevata. Questo per poca
conoscenza dei criteri di funzionamento o,
peggio, per “eccesso di voglia di visibilita”.
Facendo qualche conto risulta evidente che se
si invia il beacon ogni 3 minuti e lo stesso
viene ripetuto 5, 6 o piu volte ed il tempo di
trasmissione di un pacchetto e di circa 1
secondo, moltiplicandolo per 100 o piu (numero
medio di stazioni presenti in frequenza),
vediamo cosa succede: UN GRAN CAOS!
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Teniamo presente poi che quasi tutte le stazioni
inviano anche lo STATUS TEXT che e a tutti gli
effetti un altro beacon, quindi il tutto €
raddoppiato.

1.1 L’invio del beacon dovrebbe essere
configurato secondo la tabella seguente

Tipo di stazione

Temporizzazione in minuti

Stazione fissa normale

10/56



Consigli sull'A.P.R.S.

20

Stazione fissa meteo

10

Stazione mobile in movimento (TM-D700 o TH-D7)

1 0 30 sec.
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Stazione mobile ferma (TM-D700 o TH-D7)

10

Stazione mobile (Tiny Trak con smart beaconing)

Automatico

Digipeater

25
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Internet

10

1.2 Di seguito una tabella su come impostare
la temporizzazione del beacon sia in Ul-View
che in apparati dedicati.

Tipo si software o apparato

Menu
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Ul-View (stazione fissa)

Setup -> Station setup -> Fixed -> 20 -> OK

Ul-View ( |stazione me}eo

Setup -> WX station setup -> Radio -> 10 -> OK

Stazione fissa (TM-D700)

Menu 3-D -> 20 min -> OK
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Stazione fissa (TH-D7 G2)

Menu 2-D (TX INTERVAL) -> 20 min -> OK

Stazione fissa (TH-D7 1° ver.)

Menu 2-7 (TX INTERVAL) -> 20 min -> OK

Stazione mobile (TM-D700)

Menu 3-D (TX INTERVAL) -> 30 sec o 1 min -> OK
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Stazione m«

bile (TH-D7 G2)

Menu 2-D (

X INTERVAL) -> 30 sec 0 1 min -> OK

Stazione mq

bile (TH-D7 1° ver)

Menu 2-7 (1

X INTERVAL) -> 30 sec 0 1 min -> OK

Tiny Trak

Selezionare

lo smart beaconing in programmazione
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1.3 Un complemento al beacon e lo Status
Text, che invia informazioni supplementari al
beacon principale del tipo: la stazione piu
lontana ricevuta in diretta, la versione del
software in uso od un testo libero a scelta. In
caso di trasmissione anche dello Status Text
guesto deve essere impostato a non meno di
20 minuti. Di seguito la solita tabella.

Tipo di software o apparato

Menu

Ul-View
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Setup -> Status text -> Interval -> 20 -> OK

TM-D700

Menu -> 3-6selezionare

-> OK

TH-D7 G2

Menu -> 2-9selezionare

-> OK
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TH-D7 1° ver.

Menu -> 2-4selezionare| -> OK

1.4 Una osservazione per le stazioni mobili.
Purtroppo molto spesso chi usa apparti dedicati
Kenwood si “dimentica” quando si ferma a
lungo tempo di cambiare la temporizzazione del
beacon. Questo comporta un intasamento della
frequenza con dati sempre uguali. Quando ci si
ferma a lungo e opportuno impostare la
temporizzazione del beacon a non meno di 10
minuti.

1.5 Per forzare la trasmissione del beacon a
tutte le stazioni presenti in frequenza (che
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utilizzano Ul-View) si puo usare il comando
Action -> Query all stations o premere F11. Per
forzare invece la trasmissione del beacon ad
una stazione specifica che si presume possa
essere presente in frequenza, si puo inviargli il
messaggio 7APRSP. Un altro malvezzo ¢ il
continuo invio di messaggi del tipo: “non ti vedo
iIn mappa, fai F11”, oltre ad intasare come
sempre inutilmente la frequenza é piu efficace
inviare un ?APRSP. Questo ovviamente,
specialmente il Query all station va usato con
molta parsimonia.

Capitolo 2: indirizzamento del beacon

Come ha detto I'autore di Ul-View Roger Barker
G4IDE il digipeating non € una scienza esatta.
Si tenga sempre presente che si trasmette un
pacchetto digitale non indirizzato ad una
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stazione specifica e quindi prende una strada
gualsiasi, quindi non si puo sapere a priori chi
lo ricevera e chi lo ripetera.

La prima considerazione importante € la
distinzione fondamentale fra le stazioni normali
e quelle ripetitrici, cosiddetti DIGI,
abbreviazione di digipeater, contrazione di
digital repeater (ripetitore numerico).

Per stazioni normali si intendono i normali utenti
operanti da sistemi presidiati la cui attivita
precipua e la trasmissione dei propri dati,
indirizzati ad altri utenti sia in diretta che tramite
la rete di digi, ed eccezionalmente la
ritrasmissione di dati di altre stazioni normali.
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Per digi si intendono sistemi automatici
normalmente non presidiati il cui scopo
principale € ritrasmettere dati ricevuti da utents
normali o da altri digi e secondariamente
I'identificazione di loro stessi.

Detto questo bisogna stabilire a chi indirizzare |l
proprio beacon affinché venga ripetuto e quindi
le informazioni possano superare la normale
portata radio della nostra stazione. Ogni quanto
tempo e trasmesso il beacon (temporizzazione)
é stato descritto nel capitolo uno, ora vedremo
“a chi” indirizzare le informazioni.

2.1 La parte piu delicata per un buon
funzionamento della rete APRS e
I'indirizzamento del beacon. Non
dimentichiamoci che utilizziamo stazioni
automatiche che provvedono ad inviare |l
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beacon in tempi e modalita stabilite dall’'utente,
una volta memorizzate le impostazioni
continueranno a trasmettere spesso mal
controllate dall’'utente. Ne consegue che una
pessima impostazione genera un eccesso di
dati nelle rete che moltiplicati per il numero
degli utenti crea il collasso totale. Come
stabilire a chi si indirizza il proprio beacon
affinché venga ripetuto e quindi vada oltre la
portata della propria radio? Prima di tutto &
necessario distinguere la tipologia di stazione in
funzione della propria copertura radio, in pratica
la grossa distinzione e fra stazioni fisse e
mobili/portatili. E* chiaro che una stazione fissa
ha una portata radio maggiore di una
mobile/portatile, di conseguenza una stazione
fissa puo raggiungere piu facilmente un digi
lontano affinché i propri dati vengano ripetuti.
Per contro una stazione mobile/portatile ha
minor copertura radio e quindi necessita di
“qualcuno’ piu vicino che possa raccogliere |
suoi dati e ritrasmetterli ai digi piu lontani. Per
guesto motivo e consigliabile utilizzare due
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indirizzamenti diversi del beacon.

2.2 La filosofia di funzionamento dei digi APRS
e a "LIVELLI", che sono semplificati nella
tabella seguente.

Tipo

Livello

Utilizzo e destinazione indirizzamento
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RELAY

Basso

Ripetizione |di mezzi mobili ad aree locali o a digi di

WIDE

(obsoleto)

Alto
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Ripetizione di stazioni fisse o ritrasmissione delle rig

WIDEN-n

Alto

Ripetizione di stazioni fisse o ritrasmissione delle rig

TRAGEN-n

Alto
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Ripetizione di stazioni fisse o ritrasmissione delle rif

Nota: per n si intende un numero compreso fra
0 e 15 (es. TRACE4-4).

2.3 Una breve ma necessaria spiegazione sul
funzionamento del SSID a scalare. Ogni
qualvolta un pacchetto indirizzato ad un digi
con SSID a scalare (WIDEn-n o TRACEN-n)
viene ripetuto, l'ultimo numero viene scalato di
una unita. Ad esempio un beacon indirizzato a
TRACE3-3 dopo la prima ripetizione diventera
TRACES-2, poi TRACES3-1 e quando diverra
TRACES3 (non esiste 3-0) non sara piu ripetuto.
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2.4 Molte discussioni e differenti punti di
vista sono stati espressi in questi anni
sull'indirizzamento del beacon.
Sostanzialmente si tratta di adottare
I'indirizzamento a WIDEn-n o TRACEN-n. |
sostenitori della tesi del WIDEn-n adducono
come vantaggio la minor lunghezza del
pacchetto con tutti i vantaggi facilmente
immaginabili, ma questo e l'unico punto a
favore del WIDEnN-n. Il TRACEN-n introduce ad
ogni ripetizione il nominativo del digi che ha
ripetuto I'informazione e quindi tutto il pacchetto
si allunga.

2.4.1 WIDEnNn-n. Pro: pacchetto piu corto.

2.4.2 Contro: non si vede il path del pacchetto
e quindi non si sa quale digi lo hanno ripetuto.
Con questo sistema non si puo stabilire quale
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digi usare per inviare un messaggio ad una
stazione che non si riceve in diretta.

2.4.3 Contro: non si sa quali digi funzionano e
quali no.

2.4.4 Contro: se una stazione non autorizzata
si attiva come digi ad ampia copertura non si
vede.

2.4.5 Contro: non si possono identificare
doppie ripetizione in zone al alto numero di digi.

2.4.6 Contro: non si vededono interessantsi
fenomeni di propagazione del segnale.
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2.4.7 Contro: quando si trasmette la conferma
di ricezione di un pacchetto (ack) non sapendo
da quali digi e’ stato ricevuto il messaggio
ritrasmette I'ack a digi generici WIDEN-n
coinvolgendo quindi una gran quantita di digi
che interessano l'area di pertinenza.

2.4.8 TRACEN-n. Contro: pacchetto piu lungo,
anche se con gli accorgimenti descritti in
seguito si puo contenere la lunghezza.

2.4.9 Pro: si vede il path del pacchetto e
quindi si vede quali digi lo hanno ripetuto.
Importante per stabilire quale digi usare per
Inviare un messaggio ad una stazione che non
si riceve in diretta.
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2.4.10 Pro: si vede quali digi funzionano e quali
no.

2.4.11 Pro: se una stazione non autorizzata si
attiva come digi ad ampia copertura si vede.

2.4.12 Pro: si vedono eventuali doppie
ripetizioni.

2.4.13 Pro: si vedono i fenomeni di
propagazione.

2.4.14 Pro: quando si trasmette la conferma di
ricezione di un pacchetto (ack) percorre in
senso contrario la strada "tracciata" dal proprio

31/56



Consigli sull'A.P.R.S.

beacon senza interessare tutti gli altri
digipeaters come farebbe il WIDEN-n.

2.5 Dopo molte osservazioni fatte, credo che
un buon compromesso fra un pacchetto non
eccessivamente lungo e tutti i vantaggi
dell'utilizzo del TRACEN-n sia I'adottare un
TRACE con poche ripetizioni, con un massimo
di 4 ripetizioni. Ribadisco che I'obbiettivo
dellAPRS e quello di una buona copertura e
affidabilita delle informazioni trasmesse in
grandi aree locali, non fare DX (vedi
introduzione).

2.6 In considerazione di quanto sopra ecco la
tabella di configurazione di indirizzamento del
beacon:
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Tipo di stazic

A4

ne

bstazioni Ul-View

lmp(

tazioni RTX Kenwood

1POS

Mg

bile/portatile

RS

RELAY,TRACES3-3

R

ELAY, TRACE3-3
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Fissa

AF

RS, TRACE4

A

TRACE4-4

2.7 E’importantissimo che le stazioni fisse non
indirizzino il proprio beacon a RELAY, questo
dev’essere lasciato come punto di accesso alle
stazioni mobili/portatili che hanno meno
copertura radio e quindi necessitano di un
punto intermedio per I'accesso ai digi ad ampia
copertura.2.8 E’ ancora piu da evitare l'invio
del beacon a path multipli tipo

RELAY ,WIDE7-7,TRACE7-7. In questo modo le
ripetizioni sono eccessive (nell’esempio
1+7+7=15). Cosi facendo si genera una
guantita di ripetizioni tali da occupare
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eccessivamente la frequenza ottenendo come
risultato di lasciare meno spazio alle altre
stazioni. Avete presente chi usa i kilowatt in 40
metri per parlare da Roma a Milano?

2.9 Di seguito la tabella su dove andare a
mettere le precedenti impostazioni:

Tipo di software o apparato

Menu

Ul-View (stazione fissa)

Setup -> Station setup -> Unproto address -> APRS
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Kenwood TM-

D700 (fisso)

Menu 3-B Packet Path -> TRACE4-4 -> OK

Kenwood TM-

D700 (mobile)

Menu 3-B Packet Path -> RELAY, TRACE3-3 -> OK

Kenwood TH-D7 (fisso)

Menu 2-8 Packet Path -> TRACE4-4 -> OK
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Kenwood TH-D7 (mobile)

Menu 2-8 Packet Path -> RELAY, TRACES3-3 -> OK

Kenwood TH-D7G2 (fisso)

Menu 2-B Packet Path -> TRACE4-4 -> OK

Kenwood TH-D7G2 (mobile)

Menu 2-B FBacket Path -> RELAY, TRACES3-3 -> OK
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Capitolo 3: caratteristiche del digipeater

La catena dei digi € la struttura portante della
rete APRS. Questi permettono ad un segnale
anche minimo di coprire vaste aree locali. E’
evidente che le strategie da adottare per i digi
devono essere accurate per fare in modo che
tutto funzioni a dovere. La prima
considerazione importante da fare é che |
ripetitori digitali APRS si differenziano dai
normali ripetitori analogici in fonia per diversi
aspetti. Prima di tutto i digi APRS sono tutti non
solo sulla stessa banda dei 2 metri, ma
addirittura sulla stessa frequenza di 144.800
MHz a differenza dei ripetitori analogici fonia
che vanno dai 29 MHz fino ai GHz. Inoltre i
ripetitori analogici hanno toni sub-audio diversi
che consentono un accesso selettivo mentre in
APRS in linea di massima non possiamo
stabilire a priori quale digi ripetera il nostro
segnale. Per questi motivi ed altri necessitano
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di una struttura di coordinamento piu
organizzata in modo da ottimizzare il loro
funzionamento.

Le caratteristiche a cui dovrebbe rispondere un
digi APRS sono:

Ottima copertura radio

Presenza in aria costante

Affidabilita

Non vicinanza con altri digi

Ubicazione in aree ad alta densita di utenti
o in altura

6. Possibilita di controllo da remoto e SysOp
attento

/7. Coordinamento

ok~
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3.1 Copertura radio. E’ abbastanza evidente il
significato, questa caratteristica €' comune a
qualsiasi tipo di ripetitore. Il fatto di essere in
posizione strategica e quindi con buona
copertura radio garantisce una buona diffusione
del segnale

3.2 Presenza costante in frequenza. Purtroppo
molto spesso si assiste all’attivazione di digi
che dopo breve tempo spariscono. Questo per
prove improvvisate o altri motivi. Questo
comporta disfunzioni nella rete specialmente
per quanto riguarda la pianificazione di altri digi.

3.3 Affidabilita. Il criterio generale per
I'approccio alla gestione di un ripetitore
radioamatoriale dovrebbe essere di tipo
professionale e cioe I'impianto deve essere
realizzato con la massima cura tenendo
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presente che spesso si tratta di installazioni non
presidiate e difficili da raggiungere. Un impianto
eseguito con criteri professionali significa
affidabilita nel tempo.

3.4 Vicinanza con altri digi. Da evitare
assolutamente l'installazione di digi in
prossimita di altri. Digi vicini oltre ad essere
inutili e dannosi, accorciano la distanza che un
pacchetto APRS puo percorrere in quanto
scalano I'SSID in poca distanza (vedi punto
2.3).

3.5 Ubicazione. E’ evidente che la scelta su
dove installare un digi deve essere fatta anche
in base alla quantita di utenti da servire e di
conseguenza la locazione dovrebbe essere
scelta in base all’'area piu vasta possibile che il
digi dovrebbe servire.
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3.6 Come al punto 3.3 ho accennato a criteri di
professionalita nell'installazione, sarebbe
auspicabile che il digi possa essere attivato e
configurato da remoto in modo da poter variare
la configurazione in qualsiasi momento. Inoltre
la scelta del sysop (SYStem OPerator, colui
che si occupa del funzionamento) dovrebbe
essere fatta in base alle competenze, alla
disponibilita e alla reperibilita del sysop.
Sembra banale ma troppo spesso ci sono digi
che sono installati, dimenticati € non si sa piu
chi e come li gestisce. Utile anche mettere nel
beacon del digi il nome del SysOp in modo che
chiunque possa avere un riferimento per
segnalare eventuali problemi o
malfunzionamenti.

3.7 Coordinamento. E’ il punto piu importante.
La rete digi deve essere coordinata e
organizzata. Un coordinatore nazionale
dovrebbe tenere I'elenco dei digi, la loro
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ubicazione, I'area di copertura, i SysOp
responsabili. Questo per ottimizzare la loro
copertura. Sarebbe opportuno sfoltire dove ce
ne sono troppi e metterne dove mancano.

3.8 Una stazione normale non si deve
assolutamente configurare come digi. Anche
per fare delle prove. Questo per evitare tutti i
problemi descritti in questo capitolo. Accertarsi
quindi che nel menu di Ul-View -> Setup —>
Digipeater Setup non ci sia spuntata la casella
Enable Digi. Non c’e nessuna sperimentazione
nel configurare la propria stazione come digi ad
alto livello. Non vedo quale sia la
sperimentazione nello spuntare la casella
“enable digi” e vedere che si e diventati un digi,
e logico che funziona! L’unico effetto che si
ottiene € quello di creare ulteriore caos a quello
gia esistente. Ci sono pero delle eccezioni che
riguardano alcune stazioni normali configurate
come digi RELAY. Chi ritiene di essere in una
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posizione strategica, buona copertura radio,
sufficientemente lontano da digi ad alto livello e
da altri eventuali digi Relay, chi ha una
presenza costante in frequenza, chi abita in
centri urbani medio/grandi dove e difficile per i
mezzi mobili/portatili accedere ai digi ad alto
livello, si puo configurare come digi RELAY.
Questo subordinato ai criteri di cui sopra, con
I'identificazione del proprio digi (Setup ->
Digipeater setup -> Alias substitution, proprio
nominativo nel sub alias e impostare come sub
aliases RELAY,PROPRIO_NOMINATIVO.

Capitolo 4: messaggi

| messaggi in APRS sono uno strumento molto
valido ma se usati male sono una delle
principali cause dell’laumento sconsiderato e
inutile del traffico in rete. Di seguito alcune
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norme di comportamento che si dovrebbero
osservare per un utilizzo corretto.

4.1 Non dimentichiamoci che siamo
Radioamatori e quindi il contenuto delle
conversazioni deve essere conforme al codice
di regolamentazione delle comunicazioni
radioamatoriali. | messaggi in APRS non
devono essere una “chat” o peggio. Purtroppo
si assiste gia al penoso spettacolo dei ripetitori
In fonia, qui non solo si rischia che il contenuto
raggiunga tutto il mondo grazie ai server
RF/internet ma rimane tutto scritto e
memorizzato.
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4.2 Limitare le conversazioni allo stretto
necessario che non giustifichi 'uso della fonia.
Utilizzare la scrittura minuscola, il tutto
maiuscolo equivale ad alzare il tono della voce
e non sta bene.

4.3 Prestare la massima attenzione al campo
digi della finestra messaggi. Sul’argomento
anni fa avevo gia sottoposto il problema a
Roger G4IDE ma purtroppo la malattia I'ha
portato via prima che potesse modificare
Ul-View. Il fatto e questo: se non si specifica
niente nel campo digi della finestra messaggi di
Ul-View il programma trasmette il messaggio
utilizzando come path cio che € stato impostato
nell’'unproto address (vedi punto 2.6). Quindi se
trasmettiamo un messaggio alla stazione a
pochi Km di distanza senza specificare niente
del campo digi in effetti il nostro messaggio
percorrera tutta la rete digi e sara visibile per
una vasta area in RF e per tutto il mondo
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tramite internet. Cosa mettere allora nel campo
digi? Prima di tutto se il destinatario dei
messaggi e ricevuto in diretta (lo si vede nei
dettagli della stazione nella finestra effective
digi path che e vuota) nel campo digi della
finestra messaggi dovra essere scritto qualcosa
che non sia un nome di un digi 0 un
indirizzamento per i digi. Si potrebbe scrivere
LCL, oppure 1, oppure LOCALE, oppure PIPPO
eccetera; insomma qualsiasi cosa purché non
venga lasciato il campo vuoto. Se invece la
stazione destinataria del messaggio € ricevuta
tramite la ripetizione di uno o piu digi si digita il
o i digi con cui € stata ricevuta nel campo digi
della finestra messaggi. Da questo si capisce
iImmediatamente |la grande differenze fra
WIDEN-n e TRACEN-n, col primo non
sapremmo mai da quale digi abbiamo ricevuto
una stazione con TRACEnN-n si! Tutto questo
vale solo per Ul-View ovviamente. Per gli
apparati dedicati Kenwood non & possibile.
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Capitolo 5: varie

Qui di seguito saranno elencati comportamenti
vari che possono risultare dannosi per il buon
funzionamento del sistema APRS.

5.1 Emergenze. Il trasmettere un segnale di
emergenza senza che corrisponda al vero non
solo & un comportamento irresponsabile a
prescindere dallAPRS, ma attiva nei
ricetrasmettitori dedicati Kenwood l'allarme
emergenza che consiste nella scritta
“EMERGENCY!” a tutto schermo e
nell’emissione di segnali acustici. Questo e
assolutamente da evitare, anche solo per fare
delle prove.
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5.2 Nominativi. Sembra assurdo ma mi trovo
nella necessita di ricordare che ogni
Radioamatore € in possesso di un nominativo
radio rilasciato dal Ministero ed e quello che va
usato. ldentificativi come “CER”, “”ARIRE”;
“PROCIV?”, ed altri di questo genere sono
FUORILEGGE!

5.3 Oggetti. Cosa sono ? Sono indicazioni
virtuali che una stazione trasmette per
segnalare qualcosa di rilevante e degno di
importanza agli altri. Non sono stazioni vere. Si
riconoscono perché il fondo della casella €
azzurro. Qui si € visto di tutto e di piu. Dalla
fiera paesana al ristorante dell'amico passando
per I'oggetto di se stessi posizionato nella
stessa posizione della stazione. Sono
assolutamente inutili!. La segnalazione di una
sezione ARI puo essere utile ma interessa solo
localmente, quindi € da trasmettere solo in
ambito locale senza interessare la rete di digi
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per la ripetizione. Per la segnalazione dei
ripetitori sarebbe meglio creare degli overlays
che la stazione interessata alla visualizzazione
dei ripetitori si carica in loco senza trasmetterli
In aria. Attenzione anche agli oggetti che
indicano condizioni meteo. La segnalazione di
un evento meteo particolare va bene ma deve
essere fatta con attenzione e non dimenticata in
trasmissione per ore o giorni anche quando
I'evento e passato ma soprattutto la fonte delle
iInformazioni deve essere sicura. Ad esempio
una buona fonte di informazioni meteo
potrebbero essere i Volmet aeronautici (Milano
su 126.6 MHz).

5.4 Icone. L’icona ¢ il primo colpo d’occhio che
si ha su una stazione, la sua scelta deve
rappresentare la caratteristica delle stazione e
quindi corrispondere alla realta. La classica
casetta gialla per le stazioni normali va bene,
se si e attivi anche in HF quella verde.
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5.5 SSID. L'SSID (Station Supplementary
|Dentification) agli albori del’APRS serviva ai
primi programmi per APRS in DOS per
assegnare l'icona alla stazione, ora non € piu
cosi ma gli SSID tornano utili per identificare
alcune tipologie particolari di stazione o per
distinguere stazioni diverse di uno stesso
nominativo. In particolare su usa: 0 per le
stazioni fisse normali, -7 portatili, -9 automodbili,
-10 motociclette, -11 digipeater (in ltalia), -12
jeep, -13 camper, -14 autocarri, -15 furgoni. Gli
altri, specialmente -2, -3 possono essere
utilizzati per identificare le altre stazioni
secondarie presenti in frequenza del medesimo
nominativo.

5.6 Beacon Comment. Il Beacon Comment &
una informazione trasmessa assieme al beacon
il cui contenuto € un testo di campo libero. Per
inserire le informazione del Beacon Comment
bisogna selezionare il menu Setup poi Station
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Setup e scrivere i dati nella casella Beacon
Comment. Cosa e utile e cosa no. E’ utile
scriverci il proprio nome e il QTH. E’ utile
iInserire anche la propria e-mail o la frequenza
su cui si € QRV in fonia per indicare metodi per
essere contattati alternativi al’APRS. Cosa non
e utile. E’ assolutamente inutile scriverci il
nominativo in quanto & gia trasmesso
automaticamente e sarebbe quindi una
informazione doppia. Il nominativo si vede gia
nell'icona. Evitare caratteri inutili come punti,
asterischi e lineette a gogo. Oltre a trasmettere
dati assolutamente inutili che contribuiscono
solo ad allungare i pacchetti, i TH-D7 ed |
TM-D700 non visualizzerebbero l'informazione
iIn quanto hanno una capacita limitata del
display a rispettivamente 25 e 28 caratteri
percio se iniziamo il Beacon Comment con una
serie di asterischi chi riceve con tali apparati
vede solo quelli e non 'informazione utile.
Ribadisco di scrivere minuscolo, il maiuscolo
significa alzare il tono della voce e questo non e
bello.
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5.7 Gateway Internet/RF. Molto bene
ovviamente prendere i dati radio per immetterli
nella rete internet, attenzione al contrario. Che
senso ha vedere delle stazioni lontane che si
possono contattare solo tramite un gateway
internet?

5.8 Bollettini. Un altro ottimo strumento di
diffusione di massa di notizie usato spesso
male. | bollettini servono a comunicare a tutti gli
utenti avvenimenti importanti che richiedono
attenzione. Le situazioni di routine possono
essere segnalate nel Beacon Comment o nello
Status Text. Porto ad esempio di cosa NON si
deve fare: un noto IK2 di Milano che da mesi
propaganda le sue mappe martellando la rete di
bollettini contenenti informazioni non solo
straconosciute, ma che potrebbero essere
portate a conoscenza degli utenti nei modi
sopra descritti creando molto meno traffico
inutile.
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Conclusioni

Questi sono esempi della validita e della
potenzialita dell'APRS. Concludo affermando
che tutto questo non ¢ la soluzione magica a
tutti i problemi della rete APRS, sono semplici
osservazioni fatte da chi € in continua attivita
dal dicembre 1999, ha raccolto i pareri di chi e
attivo e fattivo in APRS da tempo e ha passato
tanto tempo in monitor.

Se qualcuno ha dei consigli o correzioni da
apportare saro felice di integrarle in questo
scritto che ha come unico obiettivo quello di far
funzionare al meglio la rete APRS.

L’APRS ha delle potenzialita incredibili,
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specialmente nelle applicazioni della Protezioni
Civile. Molte di queste potenzialita non sono
state descritte qui per semplicita, purtroppo
spesso € usato male per non conoscenza delle
regole, o peggio, per spregio. Inolire €
accessibile a chiunque anche con pochi mezzi,
quasi tutti hanno in casa un computer ed una
RTX FM in 2 metri.

Un tale IW20.. di Milano ha scritto in rete che
“In APRS si puo fare quello che si vuole, tanto
non ci sono regole” a parte la dimostrazione del
livello di intelligenza dell'individuo ora le cose
sono cambiate.

Il nuovo Consiglio Direttivo dell” ARI ha
dimostrato sensibilita verso questa tecnologia
attiva da anni in ltalia che coinvolge centinaia di
appassionati. Dove prima non esisteva nessun
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organo ufficiale ma solo gruppi che dettavano
regole spesso in contraddizione fra loro, il CD
ARI ha ritenuto opportuno creare una
Coordinatore APRS come ne esiste uno per i
ripetitori, i beacon, i 50 MHz ed altro. Ha
affidato a me il compito di gestire e coordinare
'’APRS. Cerchero e faro tutto il possibile per
recuperare il tempo perduto e chiedo la
collaborazione di tutti.

L’APRS & una tecnologia dalle grandi
applicazioni se usato adeguatamente, non
facciamolo diventare un giochino stupido!

73, Marco IK2CHZ — K2CHZ
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